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Introduction

Welcome to Requisition Management, a component of Business Portal for Microsoft
Dynamics® GP. Requisition Management is a business application that employees
can use to create, approve, and modify purchase requisitions using Business Portal,
and then transfer them to purchase orders in the Microsoft Dynamics GP back
office.

Check for updated instructions

This information was current as of March 15, 2010. The documentation may be
updated as new information becomes available. Check the Microsoft Dynamics GP
documentation Web site (http://go.microsoft.com/fwlink/?LinkId=185513) for the
most current documentation.

This introduction includes the following sections:

o What's in this manual
e Symbols and conventions
e Additional resources

o Technical support
e Send us your documentation comments

What's in this manual

The Requisition Management Administrator’s Guide is designed for administrators
or other users who are responsible for installing and setting up Requisition
Management, including specifying user access rights and approval hierarchies.

This documentation is divided into the following chapters:

e Chapter 1, “Key concepts,” describes Requisition Management overview
information and key concepts.

o Chapter 2, “Installation,” explains how to install Requisition Management.

e Chapter 3, “Groups, roles, and users,” includes instructions for setting up
group, role, and user information.

* Chapter 5, “Notifications,” describes how to personalize the information in
notification e-mail messages.

o Chapter 4, “Approval hierarchies,” describes how to set up the reporting
structure in your organization, which controls the workflow of requisition
approval.

o Chapter 6, “Company settings,” explains how to enter information and specify
settings common to all requisitions.
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¢ Chapter 7, “Troubleshooting,” contains information you can use to troubleshoot

Requisition Management.

e Chapter 8, “Default group and role permissions,” lists the default permissions
associated with the groups androles that are installed with Requisition

Management.

Symbols and conventions

This manual uses the following symbols to make specific types of information stand

out.

Symbol

Description

vy
~ ”~

The light bulb symbol indicates helpful tips, shortcuts, and suggestions.

AN\

The warning symbol indicates situations you should be especially aware
of when completing tasks. Typically, this includes cautions about
performing steps in their proper order, or important reminders about
how other information in Business Portal or the back office might be
affected.

This manual uses the following conventions to refer to sections, navigation, and

other information.

Convention

Description

Create an approval
hierarchy

Italic type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as clicking items on
a menu or a toolbar or clicking buttons in a window. This example
directs you to go to the File menu and click Print.

Bold Bold type indicates the names of fields, tabs, menus, commands, and

buttons, and text you should type.

TAB Or ENTER

Small capital letters indicate a key or a key sequence.

Additional resources

In addition to this manual, the following documentation is included with this
release of Business Portal.

Manuals

The following PDF manuals are included in the Documentation folder on the
Business Portal installation media.

Business Portal Installation Guide The Installation Guide
(BusinessPortalInstallation.pdf) provides step-by-step instructions for installing

Business Portal.

Business Portal Administrator’s Guide The Administrator’s Guide
(BusinessPortal AdminGuide.pdf) explains how to set up and configure Business

Portal.

Business Portal User’s Guide The User’s Guide
(BusinessPortalUsersGuide.pdf) helps users complete day-to-day tasks in Business

Portal.
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Application manuals User and administrator manuals for each application
installed in Business Portal are available in the Documentation folder.

Help

Help is available by clicking the Help icon button, located in the upper-right corner
of any page. The help that is displayed depends on whether you open help from a
Business Portal page, a Microsoft® Windows® SharePoint® Services page, or
Microsoft Office SharePoint Server 2007 page or Microsoft SharePoint Server 2010

page.

Business Portal help When you click the Help icon button on a Business Portal
page, the relevant help topic for that page is displayed. You can use the search field
on the help page to search for information. You also can click the Home icon button
to browse the contents of the help.

SharePoint help Many of the features included in Business Portal—such as
document libraries, lists, announcements, links, and alerts—are provided by
Windows SharePoint Services. General information about these features is provided
in the Administering Business Portal help. For more detailed information, refer to
the Windows SharePoint Services help, which can be accessed by clicking the Help
icon button in the upper-right corner of any Windows SharePoint Services page. If
you're using Office SharePoint Server 2007 or Microsoft SharePoint Server 2010,
additional help related to SharePoint Server features also will be available.

Technical support

You can contact Microsoft Dynamics technical support online or by telephone. Go to
www.microsoft.com/dynamics and click the CustomerSource link or call 888-477-
7877 (in the U.S. and Canada) or 701-281-0555.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP
documentation. If you have specific suggestions or find any errors in this manual,
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use
them freely.
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Chapter 1:

Key concepts

This information explains concepts you need to understand when using Requisition
Management.

This information is explained in the following sections:

*  Requisition Management overview

*  Requisition life cycle

*  Approval hierarchies

¢ How Requisition Management integrates with Microsoft Dynamics GP
e Commitments

*  Business Portal site structure

Requisition Management overview

Requisition Management is an application that employees, managers, supervisors,

and purchasers can use to enter and approve requisitions, also known as purchase

requests, in Business Portal. Requisitions, which are requests for goods or services,

are routed to the appropriate users for review and approval, and then line items are
transferred to new or existing purchase orders in the Microsoft Dynamics GP back

office.

Requisition Management eliminates the need for a paper-based system and gives
employees an easy way to enter requisitions. It automates the routing of requisition
information from creators to approvers, and ultimately to purchase orders in
Microsoft Dynamics GP.

Users can use Requisition Management to:

e Enter, approve, or reject requisitions in Business Portal.

* Route requisitions to a supervisor for review.

* View the status of a requisition and its history information.

e Transfer line items to new or existing back office purchase orders.

¢ Consolidate line items from multiple requisitions into a single purchase order
for each vendor.

Requisition life cycle

The requisition life cycle includes all the steps or phases a requisition passes
through: creation, approval, and conversion. The life cycle in a company is defined
by the approval hierarchy. See Approval hierarchies on page 6 for more information.

Create
purchase
request

Submit Approve Final approve ig:: sr:e
9. purchase 9' purchase 9‘ purchase 9' rgquest toa
request request request purchase order

Creation phase

When you enter a requisition, you're considered the creator. You can save the
requisition and modify it later, or you can submit it to the approver.
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Approval phase

After a requisition is submitted, it is routed to the designated approver, who can
void, reject, or approve the requisition. An approver also can modify a requisition—
such as adding required information or correcting errors—and save it to act on later.

Action Description

Void Stops all further action on the requisition and sends it to history.

Reject Returns the requisition to the creator, who can modify it and resend it to the
approver.

Modify Opens the requisition, allowing the approver to modify it. For example, if the

quantity of the item is incorrect, the approver can enter the correct quantity.

Save Saves any changes to the requisition; no other action is taken and the approver can
act on the requisition later.

Approve Routes the requisition to the next approver in the approval hierarchy.

If the approver has final approval rights and the requisition is within the specified
approval limit, the approver can give the requisition final approval. If you're using
commitments, the lines are validated to ensure they don’t exceed the budget for the
specified account. If they don’t, the amounts for those lines are committed. The
requisition is routed to the purchaser.

Conversion phase

After a requisition has received final approval, the purchaser—a user who is
assigned to the Requisition Purchaser role—can transfer the requisition line items to
purchase orders in the Microsoft Dynamics GP back office. A purchaser also can
void or modify a line item—such as adding required information or correcting
errors—and save it to act on later.

Action Description

Void Stops all further action on the requisition line.

Modify Opens the requisition, allowing the purchaser to modify it. For example, if the item
quantity is incorrect, the purchaser can enter the correct quantity.

Save Saves any changes to the requisition line; no other action is taken and the
purchaser can act on the line later.

Create Transfers the requisition line items to new or existing back office purchase orders.

If you're using commitments, the amounts on the purchase order that’s created will
be committed.

If you’re using commitments, purchase orders that are created from requisition lines in
Requisition Management will have a status of Approved/Committed in the Microsoft
Dynamics GP back office. If you’re not using commitments in Requisition Management or
Purchase Order Commitments in the back office, but you are using Purchase Order
Approvals, the purchase orders will have an Approved status in the back office.

Approval hierarchies

You must use the Approval Hierarchies page (on the Administration Home page,
under Requisition Management, click Approval hierarchies) to set up the
approval hierarchy, which controls the overall approval process. This approval
hierarchy is the route a requisition follows from one approver to the next until the
requisition is converted to a purchase order. The hierarchy structure shows the roles
or users who must approve a requisition before it can become a purchase order. As a
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CHAPTER 1 KEY CONCEPTS

requisition is approved, it travels up the approval hierarchy to the role or user in the
next highest level. See Chapter 4, “Approval hierarchies,” for more information.

How Requisition Management integrates with
Microsoft Dynamics GP

After a requisition has been created, passes through the approval process, and
receives final approval, a user in the Requisition Purchaser role will transfer the
requisition line items to new or existing Microsoft Dynamics GP purchase orders.
During the transfer process, the purchaser can consolidate identical line items from
multiple requisitions into one line item for one vendor. The purchaser can transfer
line items in Requisition Management without being set up as a Microsoft
Dynamics GP back office employee.

If you're using Purchase Order Commitments in the Microsoft Dynamics GP back
office and you've activated the commitments functionality in Requisition
Management, requisition lines will be committed when they’ve received final
approval. When a purchase order has been created from the requisition lines, the
purchase order amounts will be committed in the back office. The purchase orders
that are created from Requisition Management will have a status of Approved/
Committed in the back office.

~~~ You can’t enter an allocation account for a requisition line item if you're using commitments
in Requisition Management.

Commitments

You can use the commitments functionality in Requisition Management to work
with Purchase Order Commitments in Microsoft Dynamics GP. Commitments are
requisition or purchase order line amounts that you’ll be paying at a later date, but
that you haven’t been invoiced for yet. You can use Requisition Management to
track commitments for requisitions, and Purchase Order Commitments to track
commitments for purchase orders.

You can use requisition commitments to validate these committed amounts against
budgets on a period, year-to-date, or annual basis, and receive warnings about
requisitions that exceed the budget. Budgeted versus actual and committed
expenditures also are displayed for both requisitions and purchase orders.

These budget validations occur when you save requisition lines or attempt to give
them final approval. See the Requisition Management User’s Guide for more
information about commitments.

Business Portal site structure

Business Portal is composed of multiple web sites. The top-level site contains the
main Home page and the administration pages for Business Portal and its
applications. Each Business Portal center is a subsite that contains pages related to a
particular department or role.
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The following illustration shows the Business Portal site structure. (You may have
additional center subsites in your implementation.)

Top-lavel
Business
Portal sita
) ) Human
Finance Sales Purchasing Resources
Centar sila Centar sila Center sita ) .
Center site

You must use the top-level web site to perform administrative tasks for Business
Portal and its applications. However, you can administer SharePoint users, groups,
and content on each subsite.

For more information about site administration, refer to the Business Portal
Administrator’s Guide.
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Chapter 2:

Installation

This information explains how to install Requisition Management and describes the
Microsoft Dynamics GP back office requirements.

Installation information is explained in the following sections:

e Microsoft Dynamics GP back office requirements
o Install Requisition Management

Microsoft Dynamics GP back office requirements

Requisition Management shares data with Microsoft Dynamics GP Purchase Order
Processing. Before you install Requisition Management, you should verify that
you're registered for Purchase Order Processing, and that it has been set up on the
back office server.

You can use the commitments functionality in Requisition Management to work
with Microsoft Dynamics GP Purchase Order Commitments. Before you can use
commitments for requisitions, you must activate Purchase Order Commitments in
the back office for the same company you're working with in Business Portal, and
then activate commitments in Requisition Management.

See the Microsoft Dynamics GP Purchase Order Enhancements documentation for
more information about Purchase Order Commitments, and Set up Requisition
Management for a company on page 32 for information about activating commitments
in Requisition Management.

Before you can start or stop using commitments in Requisition Management, you must be
sure that the lines for all requisitions that have received final approval are either transferred
to purchase orders in Microsoft Dynamics GP or voided.

Install Requisition Management

If you did not install Requisition Management when running the Business Portal
installation wizard, use the Setup Wizard to add it to your Business Portal
installation. If you’ve installed Business Portal on multiple web servers, you must
add Requisition Management to each of them.

Before installing
Before you can install Requisition Management, you must:

e Verify that you're registered for Requisition Management in the back office. You
can view the applications you're registered for using the Microsoft Dynamics
GP Options window. Refer to your Microsoft Dynamics GP documentation for
more information.

¢ Verify that you are a member of the Administrators group on the Business
Portal server.
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CHAPTER 2 INSTALLATION

To install Requisition Management
To install Requisition Management, you must run the Setup Wizard.

1. From the Business Portal installation media, double-click the CDSetup.exe file.

2. Under Install, click Business Portal for Microsoft Dynamics GP.

For detailed instructions, refer to the Business Portal Installation Guide.
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Chapter 3:

Groups, roles, and users

This information contains the steps you need to follow when selecting settings
specific to Requisition Management for groups, roles, and users. We recommend
setting up groups, roles, and users before adding groups and roles to the approval
hierarchy.

Role and user information is explained in the following sections:

¢ Groups and roles for Requisition Management
o Select requisition settings for a role
®  Select requisition settings for a user

Groups and roles for Requisition Management

~

Ay

-

To use Business Portal, all users must be assigned to both Microsoft Business
Framework (MBF) roles and SharePoint groups. MBF roles determine the access
that users have to data, while SharePoint groups determine the access users have to
the sites, pages, and other elements that display data.

For more detailed information about roles and groups, see the Business Portal
Administrator’s Guide.

The following table lists the SharePoint groups and MBF roles that are used with
Requisition Management. Users must be assigned to both roles and groups so they
have the necessary access to the pages and data they need to complete their tasks.

SharePoint group MBF role Assign to
BP Requisition Creator Requisition Creator | Users who will create, modify, and submit
requisitions.
BP Requisition Approver | Requisition Users who will approve, return, reject, void,
Approver and modify requisitions.
BP Requisition Purchaser | Requisition Users who will void and modify requisition
Purchaser lines, and transfer them to purchase orders.
BP Requisition Requisition Users who will manage requisition settings for
Administrator Administrator roles and users, manage approval hierarchies,
and set up notifications and company
requisition information.

See Chapter 8, “Default group and role permissions,” for information about the
default site and page permissions associated with the SharePoint groups, and the
default data permissions associated with the MBF roles.

Only the Business Portal administrator can assign users to MBF roles and SharePoint
groups, so you'll need to work with that user. See the Business Portal Administrator’s Guide
for step-by-step instructions for completing these tasks.

REQUISITION MANAGEMENT ADMINISTRATOR'S GUIDE 1
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Select requisition settings for a role

You can use the Roles page to specify settings for the roles in Requisition
Management. A role represents a group of users who share a common job function.
After the Business Portal administrator adds users to Requisition Management
roles, you can assign role-specific settings, including the approval limit for a role,
whether users in a role can give a requisition final approval, and whether users can
modify their default approvers.

- These settings are not company specific; the settings you specify for each role will be used for
-@_ this role in all companies.

By default, the Requisition Administrator role has an unlimited approval limit and
can give requisitions final approval. You can modify these settings.

A user can be assigned to a single role or multiple roles for Requisition
Management. If a user is assigned to multiple roles and each role has its own
approval limit, the approval limit that’s used is determined by the approval
hierarchy, which sets up a requisition workflow for a company—that is, the route a
requisition follows from one approver to another. See Approval limits in the approval
hierarchy on page 16 for more information.

To remove a role from Business Portal, you must work with the Business Portal
administrator. You can’t remove a role if there is a work item assigned to that role.
For example, if a requisition is assigned to the Manager role, you can’t remove the
Manager role from Business Portal until the requisition is approved or submitted to
the next role in the approval hierarchy

Use the following procedure to specify settings for Requisition Management roles.

1. Go to the Administration Home page on the Business Portal web site.

2. Under Requisition Management, click Roles. The Roles page appears.

3. In the Role List, select the role to specify requisition settings for.

4. Click Modify.

5. Type the approval limit, which is the maximum requisition amount that users in
this role can final approve. If users in this role should have no approval limit,

select Unlimited. See Approval limits in the approval hierarchy on page 16 for more
information.
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6. You can select the following check boxes to extend the approval permissions for
the role:

* Select Final Approver to give users in this role permission to give
requisitions final approval.

* Select Change Approver to allow users in this role to send requisitions to
someone other than their default approvers.

- Users with final approver rights can’t give final approval to requisitions that they ve
created unless you select Final Approver for Self on the Users page. See Select
requisition settings for a user on page 13 for more information.

7. Click Save.

Select requisition settings for a user

You can use the Users page to assign specific settings to individual Requisition
Management users, such as whether users can give requisitions final approval,
approve requisitions for anyone beneath them in their approval hierarchies, or
modify their default approvers.

User-specific settings also determine the access each user has to certain fields when
they’re creating, modifying, or approving a requisition. You'll determine whether
the Account, Item Number, Price, Site ID, and Vendor ID fields will be displayed,
and whether they can be modified. For example, you can hide some fields if you
don’t want employees to see restricted information. You also can display certain
fields and make them non-editable if you want users to be able to see the field
information but not modify it.

You also can use the Account Security area of the Users page to specify which
accounts a Requisition Management user can access. The Account Security area
will be visible only if account security has been activated in the back office. See the
Microsoft Dynamics GP System Setup documentation for more information.

User settings are not company specific; if a user is assigned to multiple companies,
the settings you specify for that user will be used for all companies. However, the
approval options that are available for users might differ per company, depending
on the approval options you select for each company on the Company Settings
page. If you select that users in one company can approve their own requisitions but
can’t in another company, and a user is assigned to both companies, the available
approval options for that user might vary, depending on which company is selected
in the Company list. See Approval hierarchy information on page 30 for more
information.

Use the following procedure to specify settings for Requisition Management roles.
1. Go to the Administration Home page on the Business Portal web site.

2. Under Requisition Management, click Users. The Users page appears.

3. In the User List, select the user to select settings for.

4. Click Modify.

REQUISITION MANAGEMENT ADMINISTRATOR'S GUIDE 13
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Type the approval limit, which is the maximum requisition amount that a user
can final approve. If the user should have no approval limit, select Unlimited.
See Approval limits in the approval hierarchy on page 16 for more information.

You can select the following check boxes to extend the approval permissions for
the user:

¢ Select Final Approver for Others to allow the user to give final approval to
other users’ requisitions.

¢ Select Final Approver for Self to allow the user to give final approval to
their own requisitions.

¢ Select Extended Approver to allow the user to approve requisitions
assigned to anyone beneath them in the approval hierarchy.

* Select Change Approver to allow the user to send requisitions to someone
other than their default approver.

In the Line Item Field Access area, specify the access levels for the Account,
Item Number, Price, Site ID, and Vendor ID fields for when a user creates
requisitions:

¢ If you select Hidden, the user will not see the fields.
¢ If you select Editable, the user can enter information in the fields.

e If you select Not editable, the user can view the fields, but can’t enter
information in them.

We recommend that the Account field not be hidden for final approvers. If final
approvers can’t see the Account field, those users won't be able to view some of the line
item errors that might occur on the requisition.

If you're using account security in Microsoft Dynamics GP, select a user profile
in the Account Security area to restrict which accounts this user can access. An
account security user profile is a back office user ID that has access to specific
accounts. If you select a user profile on this page, the account access rights
assigned to that user profile will be assigned to this Requisition Management
user.

If you don’t select an account security user profile on this page, the default
profile—specified on the Company Settings page—is assigned to the user. If
you've selected to give this user access to all accounts using the Organizational
Structure Assignment window in Microsoft Dynamics GP, this user will have
access to all accounts regardless of the account security settings.

See Set up Requisition Management for a company on page 32 for information
about setting up the default account security user profile for Requisition
Management.

Click Save.
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Approval hierarchies

This information describes how to set up an approval hierarchy for requisitions.
Users and roles must be added to an approval hierarchy before users can submit
requisitions.

Approval hierarchy information is explained in the following sections:

e About approval hierarchies

e Before you create an approval hierarchy

*  Approval limits in the approval hierarchy

*  Approval limits examples

e Create an approval hierarchy

e Add roles and users to an approval hierarchy

e Modify an approval hierarchy

*  Replace a role or user in an approval hierarchy

o View properties for a role or user in an approval hierarchy
*  Remove a role or user from an approval hierarchy
e Copy an approval hierarchy

e Delete an approval hierarchy

*  Print an approval hierarchy

About approval hierarchies

An approval hierarchy defines the requisition workflow for a company, which is the
route a requisition follows from one approver to the next until the requisition is
transferred to a purchase order. The hierarchy uses a tree structure of users and
roles to control the workflow of the approval process. The structure shows the roles
or users who must approve a requisition before it can become a purchase order. As a
requisition is approved, it moves up the approval tree to the role or user in the next
highest level.

You can have an unlimited number of levels in the approval hierarchy, and you can
include a mix of roles and users. For example, suppose a hierarchy includes a team
of employees at the bottom level, with their supervisor above them in the hierarchy.
From there, the requisitions are routed to the department manager, and then finally
to the Requisition Purchaser role.

Approval Hierarchy

Select a user or role to make changes to the approval hierarchy,

S +4 |Requisitiur‘| ﬂdminiatrat:ur|
= 8 Requisition Purchaser
= “ff Pilar Ackerman (pilar - FRYISTA1G14)
= %} Don Hall (don - FRYISTA1614)
= Y% JoBerry (jo - FRYISTAL1614)
= “f Chris Gray (chris - FRVISTA1614)
Y% Toby Nixon (toby - FRVISTA1614)

Even if you add the Requisition Creator role to an approval hierarchy, the users
assigned to that role also must be added to the approval hierarchy in order for them
to create requisitions, so that the system knows which user created each requisition.
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Users who are assigned to the Requisition Approver, Requisition Purchaser, and
Requisition Administrator roles don’t need to be included in the approval hierarchy
unless you want them to be able to create requisitions.

For example, when you add the Requisition Approver role to the hierarchy, the
users who are assigned to that role will be able to give requisitions approval and
final approval. However, if the users who are assigned to that role aren’t included in
the hierarchy, they won't be able to create requisitions.

Users with final approver rights can’t give final approval to requisitions that they've created
unless you select Final Approver for Self on the Users page. See Select requisition settings

for a user on page 13 for more information.

You can use the same approval hierarchy for all the companies you have set up in
Microsoft Dynamics GP, or each company can have its own approval hierarchy. See
Chapter 6, “Company settings,” for more information.

Before you create an approval hierarchy

Only users who are assigned to both the BP Requisition Administrator group and
the Requisition Administrator role can access the Approval Hierarchies page. The
Business Portal administrator must assign a user to the Requisition Administrator
role before that user can create an approval hierarchy. Then the Business Portal
administrator must assign users or other roles to the Requisition Creator,
Requisition Approver, and Requisition Purchaser roles. See Chapter 3, “Groups,
roles, and users,” for more information.

We recommend that you add the Requisition Purchaser and Requisition Approver roles to
the approval hierarchy rather than specific users whenever possible, and then assign the
specific users to those roles. This will make it easier for you to maintain your hierarchy in the
future to accommodate both temporary and permanent changes to your hierarchy—such as
purchasers and approvers going on vacation or leaving the company—uwithout leaving
requisitions “stranded” in the hierarchy.

Approval limits in the approval hierarchy

(S

?

-

You can use the Roles and Users pages to set up approval limits and specify
whether roles and users are final approvers. You also can use the Company Setup
page to specify whether users can bypass their approvers.

See Approval limits examples on page 17 for examples of how approval limits and
settings work together in a hierarchy.

Approval limits

If you indicate that a user or role is a final approver on the Roles or Users page and
you type an amount in the Approval Limit field, this role or user can give
requisitions final approval if the requisition amount doesn’t exceed the approval
limit amount. If you select Unlimited as the approval limit, this role or user will be
able to give a requisition final approval regardless of its amount.

A requisition must receive final approval before it can be transferred to a purchase order.

There’s no restriction on the number of users who have final approval rights. By
default, the Requisition Administrator role has these rights.
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If the amount of a requisition exceeds the approval limit, the role or user still can
approve the requisition, but it won’t receive final approval. The requisition will
move up the approval hierarchy until it reaches an approver whose approval limit
exceeds the amount of the requisition, and who has final approval rights.

If a user is assigned to multiple roles and each has its own approval limit, the
approval hierarchy determines which approval limit is used. For example, suppose
Edward is assigned to two roles: the Requisition Approver role with a $100
approval limit, and the Manager role with a $1,000 approval limit and final
approval rights. Another user, Mary, submits a requisition for a $120 office chair to
the Requisition Approver role.

Because the Requisition Approver role has an approval limit of $100, Edward still
can approve the requisition, but he can’t give it final approval. If the requisition had
been submitted to the Manager role, Edward could have given the requisition final
approval, because the approval limit for the Manager role is $1,000.

Bypassing approvers

If you select Bypass Approvers on the Company Setup page, submitted requisitions
will bypass any approvers whose approval limits don’t equal or exceed the
requisition amount. The requisition instead will be routed to the next approver in
the approval hierarchy whose approval limit is equal to or exceeds the requisition
amount. For example, if Jim submits a requisition for a $990 computer to Mary, but
Mary’s approval limit is $900, the requisition will be routed to the next approver
whose approval limit is $990 or greater.

If a user doesn’t want to bypass an approver, the user still can select which approver
to send the requisition to by selecting Submit and send the purchase request to on
the Purchase Request Details page, and selecting the approver to send the

requisition to. See the Requisition Management User’s Guide for more information.

~~- Only the default approver is available in the Submit and send the purchase request to list
unless you've selected Change Approver on the Roles or Users page for this role or user.

Approval limits examples

These examples provide more information about how approval limits and settings
work together in approval hierarchies. For these examples, assume a company uses
the following approval hierarchy.

Approval Hierarchy

Select a user ar role bo make changes to the approsal hierarche,

SN |Requisitiur‘| ﬁdministrat:ur|
= F Requisition Purchaser
= “ff Pilar ackerman fpilar - FRYISTA1G614)
= 3 Don Hall (don - FRYISTA1614)
= “fF Jo Berry (jo - FRVISTA1G14)
= “f Chris Gray (chris - FRVISTA1614)
Y% Toby Mixon (toby - FRVISTALG14)
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The users in the hierarchy are set up with the following approval information.

User Approval limit Final approver?
Pilar Ackerman Unlimited Yes

Don Hall $1,000 Yes

Jo Berry $700 Yes

Chris Gray $500 No

Toby Nixon $0 No

Example 1

Toby Nixon enters a requisition for a $400 computer and clicks Submit. The
requisition is submitted to Chris Gray regardless of whether Bypass Approvers is
selected for the company, because the requisition amount is within Chris’s $500
approval limit. Chris can make any changes to the requisition, reject or void it, or
submit it to Jo Berry for final approval.

Example 2

Toby Nixon enters a requisition for a $400 computer and a $350 monitor, so the
requisition amount is $750. Whether the Bypass Approvers option is selected on the
Company Setup page determines which user the requisition is submitted to.

Scenario 1 The Bypass Approvers check box isn’t selected for the company.
When Toby clicks Submit for the $750 requisition, it is submitted to Chris Gray
because he’s the next user in the hierarchy. Chris can make any changes to the
requisition, reject or void it, or submit it to Jo Berry.

Although Jo has final approver rights, the $750 requisition exceeds her approval
limit. She still can approve the requisition, but it will be submitted to Don Hall for
final approval.

Scenario 2 The Bypass Approvers check box is selected for the company. When
Toby clicks Submit for the $750 requisition, it is automatically submitted to Don
Hall, because he’s the next user in the hierarchy whose approval limit is equal to or
exceeds $750. Don can make any changes to the requisition, reject or void it, or give
it final approval.

Scenario 3 The Bypass Approvers check box is selected for the company.
However, Toby wants her manager, Chris Gray, to see the requisition before sending
it to Don Hall for approval, because the requisition is missing the account
information. Toby clicks Show More Tasks, selects Submit and send the purchase
request to, selects Chris’s name from the list, and clicks OK.

Chris makes the appropriate changes to the requisition and clicks Approve. The
requisition bypasses Jo Berry and is sent to Don Hall, because he’s the next user in

the hierarchy whose approval limit is equal to or exceeds $750.

See the Requisition Management User’s Guide for more information about
submitting and selecting approvers for requisitions.

Create an approval hierarchy

You can use the Approval Hierarchies page to create an approval hierarchy. You can
create an approval hierarchy for each company that is set up in Microsoft Dynamics
GP, or you can create one hierarchy and assign it to multiple companies.
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When you first create an approval hierarchy, it will be empty except for the
Requisition Administrator role, which will be included at the highest position.
You’ll need to add users and roles beneath the Requisition Administrator role to set
up an approval hierarchy that meets your needs. See Add roles and users to an
approval hierarchy on page 19 for more information.

1. Go to the Administration Home page on the Business Portal web site.

2. Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

3. Inthe Pick a Task area, click Create New Approval Hierarchy. The Create
Approval Hierarchy page appears.

4. Type the name of the hierarchy.

5. Select A user or role can be in the approval hierarchy multiple times to be able
to include a user or role in the hierarchy in multiple places. If you don’t select
this check box, each user or role can exist in the hierarchy only once.

If you select this check box and then create a hierarchy with users or roles in it multiple
times, you can't clear the check box again until you modify the hierarchy so each user or

role is included in it only once.

6. Click Save and Close.

Add roles and users to an approval hierarchy

You can use the Approval Hierarchies page to add users and roles to an approval
hierarchy. When you add users and roles, you're establishing their positions in the
hierarchy, which then determine the workflow of the requisition approval process.
Only one user can add roles and users to an approval hierarchy at a time.

If a user exists in the approval hierarchy in multiple places, you can set the default
level, which is the level from which the user will submit requisitions. See Modify an
approval hierarchy on page 20 for more information. Only one of the positions in the
hierarchy can be the default level.

1. Go to the Administration Home page on the Business Portal web site.

2. Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

3. In the Approval Hierarchy List, select the hierarchy to add roles and users to.
4. Click Modify.

You can expand or collapse all the levels of the approval hierarchy by right-clicking the
top node of the hierarchy and choosing Expand All or Collapse All.
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5. You can add roles and users either above or beneath another role or user.

The following table includes more information.

To add...

Follow these instructions

or user

One or more roles beneath a role | Right-click the role or user and choose Add level

below > Role.

A role above a role or user Right-click the role or user and choose Add level

above > Role.

or user

One ore more users beneath a role | Right-click the role or user and choose Add level

below > User.

A user above a role or user Right-click the role or user and choose Add level

above > User.

Depending on whether you're adding a role or user, the Select Roles or Select
Users page appears.

6. Select the roles or users to add to the hierarchy.

S~ Approval hierarchies are not company specific so that you can use the same approval
hierarchy for multiple companies. This means that when you add users to the approval
hierarchy, the Select Users page will include the users for all companies.

7. Click Select and Close.

8. Click OK. Any changes you make to the approval hierarchy take effect
immediately. For example, if you add a user or role, that user or role will
immediately begin receiving any requisitions submitted by the level beneath it.

Modify an approval hierarchy

You can use the Approval Hierarchies page to modify an approval hierarchy. For
example, you can modify the name of a hierarchy or indicate whether a user or role
can appear more than once in a hierarchy.

You also can make the following modifications to the approval hierarchy by right-
clicking a user or role in the hierarchy and choosing one of the following commands
from the menu that appears.

Command

Description

Add level above

You can insert either a user or role in the level above.

Add level below

You can insert either a user or role in the level below.

Replace level

When you replace a role or user, the work items assigned to that role or
user will be reassigned to the new role or user. See Replace a role or user in
an approval hierarchy on page 21 for more information.

Cut, Copy, and
Paste below

The role or user you cut or copy will be saved until you use the Paste
below command, or cut or copy another role or user. When you copy a role
or user, any levels beneath the role or user also will be copied.
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Command Description

Set as default If a user is included in the approval hierarchy multiple times, you can

modify the default level, which is the level from which the user will submit
requisitions. Only one of the positions in the hierarchy can be the default
position.

Delete If you delete a role or user from the approval hierarchy, any levels beneath

the role or user will be assigned to the next level. For example, suppose
Cindy is a level above Jeff, and Jeff is a level above Becky. If Jeff is deleted,
Cindy will be a level above Becky. Any work items assigned to the deleted
role or user can be accessed by a user with extended approver rights. See
Remove a role or user from an approval hierarchy on page 22 for more
information.

The following steps describe how to modify an approval hierarchy. Only one user
can modify an approval hierarchy at a time.

1.

2.

8.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy to modify.
Click Modify.

You can expand or collapse all the levels of the approval hierarchy by right-clicking the
top node of the hierarchy and choosing Expand All or Collapse All.

Type the name of the hierarchy.
Select A user or role can be in the approval hierarchy multiple times to be able
to include a user or role in the hierarchy in multiple places. If you don't select

this check box, each user or role can exist in the hierarchy in only one place.

Right-click the role or user to modify and make the necessary changes to the
hierarchy.

Click OK.

Replace a role or user in an approval hierarchy

You can use the Approval Hierarchies page to replace a user or role in an approval
hierarchy. You can replace a user or role with another user or role. When you
replace a user or role, the work items assigned to that user or role will be assigned to
the new user or role.

You can’t replace a user if the user is included in the hierarchy in multiple places,
and the position you're replacing is the default level. The default level is the level
from which the user will submit requisitions.

1.

2.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy to modify.
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4.
5.
6.
7.

Click Modify.

Right-click the user or role in the hierarchy that you're replacing and choose
Replace level > User or Role. The Select User or Select Role page appears.

Select the user or role to add to the hierarchy and click Select and Close.
Approval hierarchies are not company specific so that you can use the same approval
hierarchy for multiple companies. This means that when you add users to the approval
hierarchy, The Select User page will include the users for all companies.

If any work items are assigned to the user or role, a message will be displayed
asking if you want to continue. Click OK. The user or role will be replaced, and

any work items will be assigned to the new user or role.

Click OK.

View properties for a role or user in an approval
hierarchy

You can use the Approval Hierarchies page to view the approval settings for roles
and the line item field access and approval settings for users.

1.

2.

6.

7.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy to view role or user
properties for.

Click Modify.

Right-click the role or user and choose Properties. Depending on whether
you're viewing role or user properties, the Role Properties or User Properties

page appears.
Click Close.

Click OK.

Remove a role or user from an approval hierarchy

If the Business Portal administrator deletes a user or role from Business Portal, that
user or role will remain in the approval hierarchy, and you must manually remove
the user or role from the hierarchy. You can use the Approval Hierarchies page to
remove users and roles from an approval hierarchy.

When you remove a Business Portal user or role, requisitions that they created and
saved are deleted, and completed requisitions are left as is. Any requisitions that are
currently assigned to the removed user or role can be accessed by a user who has
extended approver rights. See Select requisition settings for a user on page 13 for
information about giving users extended approver rights.
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If the user you're removing exists in the approval hierarchy in multiple places, you
can’t remove the default level until all the other positions are removed. If you want
to remove the position that’s specified as the default level but leave the other
positions in place, you first must designate another position as the default level. See
Modify an approval hierarchy on page 20 for more information.

1.

2.

6.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy that includes the user or
role you're removing.

Click Modify.
Right-click the user or role in the hierarchy that you're removing and choose
Delete. A message is displayed asking if you want to delete the position. Click

OK. The user or role will be removed.

Click OK.

Copy an approval hierarchy

Use the Approval Hierarchies page to create a new approval hierarchy by copying
an existing hierarchy. You then can modify the copied hierarchy, such as adding or
deleting roles and users. You can copy an approval hierarchy at any time, unless it is
being modified by another user.

1.

2.

7.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy to copy.

In the Pick a Task area, click Copy Selected Approval Hierarchy. The Copy
Approval Hierarchy page appears.

Type the name of the new hierarchy.

Select or clear the A user or role can be in the approval hierarchy multiple
times check box to indicate whether you want to be able to include a user or
role in the hierarchy in multiple places.

If the original hierarchy had this check box selected, and a role or user is included in the
hierarchy in multiple places, you won't be able to clear the checkbox. You'll need to save
the copy, remove the duplicate roles or users, and then clear the A user or role can be
in the approval hierarchy multiple times checkbox.

Click Save and Close.

Delete an approval hierarchy

You can use the Approval Hierarchies page to delete an approval hierarchy. You
can’t delete an approval hierarchy if it is being modified by another user, if it is
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assigned to a company, or if requisitions are assigned to a user or role in the
hierarchy.

If the approval hierarchy is assigned to a company, you first must unassign the
hierarchy from the company using the Company Setup page. See Set up Requisition
Management for a company on page 32 for more information.

1.

2.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy to delete.

In the Pick a Task area, click Delete Selected Approval Hierarchy. A message
will appear asking if you want to delete the selected hierarchy. Click Yes.

Print an approval hierarchy

Use the Approval Hierarchies page to print an approval hierarchy by displaying the
hierarchy in a printable format.

1.

2.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Approval hierarchies. The Approval
Hierarchies page appears.

In the Approval Hierarchy List, select the hierarchy to print.

In the Pick a Task area, click Print Selected Approval Hierarchy. The Printer-
Friendly Version page appears.

Choose File > Print to print the hierarchy.
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Notifications

This information explains how notifications are used in Requisition Management
and how you can modify them.

You can only modify the existing notifications for Requisition Management; you can’t create
new ones.

Notifications information is explained in the following sections:

e About notifications

e Automatic substitutions

o Modify an e-mail notification

o Setup tasks before sending notifications

About notifications

Requisition notifications are message templates that contain the information for
e-mail messages that are sent when an action is taken on a requisition or when a
problem occurs. You can use automatic substitutions to customize each type of
notification. You can use 10 different e-mail notifications, and each has its own set of
variables that are available for automatic substitution. See Automatic substitutions on
page 26 for more information.

When an action is taken on a requisition, notifications can be sent to the users in the
Requisition Creator, Requisition Approver, and Requisition Purchaser roles,
depending on the settings on the Company Setup page. See Sef up Requisition
Management for a company on page 32 for more information. Notifications also are
sent to users in the Requisition Administrator role if problems arise regarding users
and rights, such as when requisitions are assigned to users who don’t have access to
the proper companies.

The following table describes the notifications that can be sent to Requisition
Management users and whether they’re optional.

Notification name When used Sent to Optional

Requisition Assigned To A requisition is assigned to a | Usersin the role the | Yes

Role Notification role requisition was

assigned to
Requisition Assigned To A requisition is assigned to a | The user the Yes
User Notification user requisition was

assigned to

The creator of the Yes
requisition

Requisition Creator Final
Approved Notification

A requisition receives final
approval

The creator of the Yes
requisition

Requisition Creator
Rejected Notification

A requisition is rejected

The creator of the Yes
requisition

Requisition Creator
Transferred To PO
Notification

A requisition is transferred to
a purchase order

Requisition Creator Voided | A requisition is voided The creator of the Yes

Notification requisition
Requisition Invalid User A requisition is assigned to an | Users in the No
Notification approver who doesn't exist Requisition

Administrator role
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Notification name When used Sent to Optional
Requisition No Rights To A requisition is assigned to a | Users in the No
Company Notification user who doesn’t have access | Requisition

to a company Administrator role
Requisition Purchaser Role | A requisition receives final Users in the Yes
Notification approval and can be Requisition

transferred to a purchase Purchaser role

order
Requisition Role No Rights | A requisition is assigned to a | Users in the No
To Company Notification role that doesn’t have access | Requisition

to a company Administrator role

\\'@', Other Business Portal applications use this notification system, as well, so additional

- notification type selections may appear. For information about using notifications with other
installed applications, see the documentation for those applications.

You can modify the name, description, e-mail address, subject line, and message
body for each notification. See Modify an e-mail notification on page 26 for more
information.

Automatic substitutions

You can use automatic substitutions to create e-mail messages that are
automatically personalized for each recipient.

Automatic substitutions are variables you can use in notifications. When messages
are generated, the variables are replaced with the appropriate data for the
requisition. For example, the variable “Company Name” would be replaced with
the name of the specific company associated with the requisition.

The type of notification you're using determines which automatic substitutions are
available for the subject line and message body. For more information about each
notification type, see About notifications on page 25.

The following variables are used:

e Approver name
Approver parent name (the name of the next person up from the approver in
the approval hierarchy)
Company name
Creator name

Item description

Item number
Requisition comment
Requisition ID

Role name

User name

For more information about modifying e-mail notifications, see Modify an e-mail
notification on page 26.

Modify an e-mail notification
You can use the Modify E-mail Notification page to modify the default notifications

that are included with Requisition Management. For each notification, you can
specify a from address, subject line, and message body.
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Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Notifications. The Notifications page
appears.

Select the notification to modify in the E-mail Notifications List and click
Modify. The Modify E-mail Notification page is displayed.

Other Business Portal applications use this notification system, as well, so additional
notification type selections may appear. For information about using notifications with
other installed applications, see the documentation for those applications.

Modify the name for the notification.
Modify the description for the notification.

Type or modify the e-mail address that will appear in the From line for
messages that use this notification.

Modify the subject line for messages that use this notification.

You can insert variables from the Automatic Substitutions list. Click in the
subject line where you want the variable to appear, and then select the variable
and click Insert in Subject.

Variables are substituted with the appropriate data when each e-mail message
is generated. The notification type you selected determines which substitutions
are available. For more information, refer to About notifications on page 25 and
Automatic substitutions on page 26.

Modify the message body for messages that use this notification.
You can insert variables from the Automatic Substitutions list. Click in the
message body where you want the variable to appear, and then select the

variable and click Insert in Message.

Click Save.

Setup tasks before sending notifications

Before Requisition Management users can begin receiving notifications, you must
complete the following setup tasks:

Be sure an e-mail server and e-mail address are specified using the E-mail and
Terminal Services page. See the Business Portal Administrator’s Guide for more
information.

Set up each user’s e-mail address using the Users page for Business Portal. See
the Business Portal Administrator’s Guide for more information.

Specify whether users in the Requisition Creator, Requisition Approver, and
Requisition Purchaser roles will be notified after an action is taken on a
requisition using the Company Setup page. See Chapter 6, “Company settings,”
for more information.
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Company settings

Before using Requisition Management, you must set up system default settings for
each company that is set up in Microsoft Dynamics GP. This includes information
common to each requisition, which options are available, the approval hierarchy
used, when notifications are sent, and which account security user profile is used.
You can modify these settings at any time.

Depending on which features you're using in the back office, you might not see all the fields
on the Company Setup page.

Company settings information is explained in the following sections:

*  Requisition numbering information
*  Line item default information

*  Approval hierarchy information

*  Requisition options

*  Notification options

*  Account security
*  Set up Requisition Management for a company

Requisition numbering information

The requisition number or ID for new requisitions is formed from a prefix and next
number. The prefix can include only uppercase characters with no spaces, and the
default prefix is REQ. The next number value must be numeric; the default next
number is 0000001. The requisition number formed by these default values is
REQ0000001.

To help ensure that the number is incremented properly, we recommend that you
enter a number that ends in a numeral with leading zeros, such as the default value.
Each time you enter a requisition, the requisition number increments by one; be
sure to enter a number with enough leading zeros to fit the needs of your system’s
growth.

item default information

You can select the default entries for the site, vendor, and account that will be
displayed when a user adds items to a requisition.

Default accounts

When you're selecting the default account information and you select Item or
Vendor Account, the default account for each line will be the default account from
the item’s back office record (for inventoried items) or the vendor’s back office
record (for non-inventoried items). If no default account information is set up for
the item or vendor in the back office, the Inventory Control account specified using
the Microsoft Dynamics GP Posting Accounts Setup window will be used. If that
account also isn’t set up, there will be no default account for the line.

If you select to display the site, vendor, and account information from the previous line on a
requisition, the default site, vendor, or account for the first line will be blank.
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Site substitution for accounts

If you've specified account segments for inventory sites in the back office, site
substitution for accounts will occur in Requisition Management. This means that
the site that is specified for each requisition line item will be substituted as the value
for that segment of the line item’s account number.

For example, suppose the following accounts are set up in the Microsoft Dynamics
GP chart of accounts:

e 000-1300-00
e 100-1300-00
e 200-1300-00

The following sites are set up in inventory:

* North (uses segment 100)
* South (uses segment 200)

You create a new requisition in Requisition Management and add the 100XLG item,
which has the following inventory account assigned to it: 000-1300-00. You select
any vendor, 000-1300-00 as the account, and North as the site. In this example,
because the North site uses segment 100, site substitution will occur and the account
number will be changed to 100-1300-00.

This account number will be validated to verify that it exists in the back office; if the account
number isn’t valid, the substitution won’t occur.

See the Microsoft Dynamics GP Purchase Order Processing documentation for more
information about site substitution for accounts.

Default required-by dates

You also can specify a default value for the required-by date for requisitions by
typing a value in the Required Date Offset field. The value you enter will be added
to the current date to calculate the default required-by date. For example, if you
type 10 in the Required Date Offset field and a user creates a requisition on
December 10, the default value for the required-by date would be December 20.

Approval hierarchy information

You must select an approval hierarchy to use for the company. If you select Bypass
Approvers, requisitions will be routed to the next approver in the approval
hierarchy whose approval limit is equal to or exceeds the requisition amount. See
Approval limits in the approval hierarchy on page 16 for more information.

You also can select whether users in this company can give final approval to their
own requisitions and, if so, whether all users can or only specified users. If you
select Specified users, the Final Approver for Self option will be displayed on the
Users page. You can use this option to select which users can give final approval to
their own requisitions. See Select requisition settings for a user on page 13 for more
information.
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Requisition options

You can specify whether requisitions can be modified after they’ve received final
approval, non-inventoried items can be entered, requisitions can be copied, and
requisition amounts can be committed.

Requisitions can be edited after final approval

You can give users access to modify requisitions after they’ve been given final
approval if you want users in the Requisition Purchaser role to be able to modify a
requisition line item before transferring the line items to purchase orders. For
example, purchasers might need to void line items, or modify them so they're
identical and can be consolidated into a single line item.

Non-inventoried items can be entered

You can allow items that don’t exist in the Microsoft Dynamics GP inventory
records to be entered on requisitions.

Requisitions can be copied

You can allow users to create new requisitions by copying existing requisitions. See
the Requisition Management User’s Guide for more information about copying
requisitions.

Purchase request line amounts can be committed

If you're using Purchase Order Commitments in Microsoft Dynamics GP, you can
specify whether requisition line amounts can be committed, so you can validate
these amounts against a budget. Commitments are uninvoiced amounts from
requisitions. These amounts are committed to be paid at a later date, but you
haven’t been invoiced for the amounts yet. See the Requisition Management User’s
Guide for more information about commitments.

This option is available only when Purchase Order Commitments has been
activated in the back office. See the Microsoft Dynamics GP Purchase Order
Enhancements documentation for more information.
S Before you can start or stop using commitments in Requisition Management, you must be
sure that the lines for all requisitions that have received final approval are either transferred
to purchase orders in Microsoft Dynamics GP or voided.

Notification options

You can select whether users in the Requisition Creator, Requisition Approver, and
Requisition Purchaser roles will be notified after specific actions are taken on a
requisition. For example, you can specify that users in the Requisition Approver
role should be notified when requisitions have been assigned to them for approval.

Account security

You can type or select an account security user profile to restrict which accounts
Requisition Management users can access. This user profile is a back office user ID
that has access to specific accounts.

The Account Security area is visible only when account security has been activated

in the back office. See the Microsoft Dynamics GP System Setup documentation for
more information.
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Set up Requisition Management for a company

Use the Company Setup page to set up Requisition Management for each company
that’s set up in Microsoft Dynamics GP. The information you enter in this procedure
is specific to the company you've selected in the Company List. You must complete
this procedure for each company that requisitions will be entered for.

- Depending on which features you're using in the back office, you might not see all the fields
_@_ on the Company Setup page.

Before completing this procedure, you must set up the approval hierarchy. See
Chapter 4, “Approval hierarchies,” for more information.

1.

2.

Go to the Administration Home page on the Business Portal web site.

Under Requisition Management, click Company settings. The Company
Setup page appears.

In the Company List, select the company to set up Requisition Management for.
This list includes the companies that are set up in Microsoft Dynamics GP.

Click Modify.

In the Requisition Numbering area, type the prefix that will appear at the
beginning of each requisition number.

The prefix can’t include spaces, special characters, or lowercase letters. We
recommend that the prefix contain only uppercase letters, because if you enter a
prefix with a number, the number won’t be incremented.

Type the next number, which is appended to the prefix to form the requisition
number. This number is incremented by one with each new requisition.

In the Line Item Defaults area, select which site will appear by default as line
items are entered on requisitions:

Default Site The same default site will appear for each new line item on all
requisitions entered for this company. Select the default site.

Previous Line's Site The default site for each line item will be the site from
the previous line.

Item’s Default Site The default site for each line item will be the site from
the item’s record in the back office.

Select which vendor will appear by default as line items are entered on
requisitions:

Previous Line’s Vendor The default vendor for each line will be the vendor
from the previous line.

Item Site’s Primary Vendor The default vendor for each line will be the
primary vendor for the selected site from the item’s record in the back office.
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Select which account will appear by default as line items are entered on
requisitions:

Previous Line’s Account The default account for each line will be the
account from the previous line.

Item or Vendor Account The default account for each line will be the
default account from the item’s record in the back office (for inventoried items),
or the default account from the vendor’s record in the back office (for non-
inventoried items).

In the Required Date Offset field, type the number of days to add to the
current date to calculate the default required-by date.

In the Approval Hierarchy area, select the approval hierarchy to use for this
company.

Select Bypass Approvers if you want a requisition to be routed to the next
approver in the approval hierarchy whose approval limit is greater than the
amount of the requisition. See Approval limits in the approval hierarchy on page 16
for more information.

Select Users can give final approval to their own requisitions if you want
users in this company to be able to give final approval the requisitions they’'ve
created. If you select this option, select whether all users can give final approval
to their own requisitions, or only selected users. See About approval hierarchies on
page 15 for more information.

In the Requisition Options area, select the options to use for requisitions in the
selected company:

Requisitions can be edited after final approval Allow users to modify
or void requisition line items after they’ve received final approval.

Non-inventoried items can be entered Allow users to enter items that
don’t exist in the back office inventory records on requisitions.

Requisitions can be copied Allow users to create new requisitions by
copying existing requisitions. See the Requisition Management User’s Guide
for more information.

Purchase request line amounts can be committed Allow users to
commit requisition line amounts so you can validate these amounts against a
budget. See the Requisition Management User’s Guide for more information.

Before you can start or stop using commitments for a company in Requisition
Management, you must be sure that the lines for all requisitions that have received final
approval are either transferred to purchase orders in Microsoft Dynamics GP or voided.
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15.

16.

17.

In the Notification Options area, select when e-mail notifications should be
sent to users in the Requisition Creator, Requisition Approver, and Requisition
Purchaser roles for the selected company:

*  You can specify that users in the Requisition Creator role should be notified
when a requisition receives final approval, is rejected, is transferred to a
purchase order, or is voided.

*  You can specify that users in the Requisition Approver role should be
notified when a requisition has been assigned to them for approval.

*  You can specify that users in the Requisition Purchaser role should be
notified when a requisition receives final approval and is ready to be
transferred to a purchase order.

We recommend that you verify whether the notification message templates that will be
sent to users in the Requisition Creator, Requisition Approver, and Requisition
Purchaser roles are ready to be used. See Chapter 5, “Notifications,” for more
information.

In the Account Security area, type or select a user profile in the User Profile
field to restrict which accounts Requisition Management users can access. This
user profile is a back office user ID that has access to specific accounts. If you
select a user profile on this page, the accounts assigned to the profile will be
applied to all Requisition Management users.

To assign an account security user profile to each user, use the Users page. See
Select requisition settings for a user on page 13 for more information.

The Account Security area is visible only when account security has been
activated in the back office. See the Microsoft Dynamics GP System Setup
documentation for more information.

Click Save.
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Troubleshooting

This information explains some issues you might encounter when using Requisition
Management and how to resolve them.

This information is divided into the following sections:

*  Requisitions aren’t moving through the hierarchy because an approver is out
o Company is being modified by another user

*  Purchase request is being modified by another user

*  Failed conversion of a requisition to a purchase order

Requisitions aren’t moving through the hierarchy
because an approver is out

If users who are assigned to the Requisition Approver role are out of the office, the
requisitions that are currently or will be assigned to those approvers may become
“stranded” in the approval hierarchy.

For example, suppose you've set up the following approval hierarchy.

Approval Hierarchy

Select a user or role bo make changes to the approval hierarchy,

= ﬂ|RequisitiDn ﬂdminist’ab:lr|
= € Requisition Purchaser
= MG Pilar Ackerman (pilar - FRVISTA1614)
= % Don Hall (don - FRYISTA1614)
Y% 1o Berry {jo - FRVISTA1614)
Y% Chris Gray (chris - FRYISTA1614)

Pilar and Don are both assigned to the Requisition Approver role, and Jo and Chris
are assigned to the Requisition Creator role. For this example, suppose Don is
leaving on vacation for four weeks. You have multiple options for dealing with the
requisitions from Jo and Chris while Don is away.

Option 1: Make another approver an extended approver

You can use the Users page to make another approver in the hierarchy an extended
approver, so that user can approve requisitions that are assigned to anyone beneath
them in the hierarchy.

In this example, you make Pilar an extended approver, so she can approve any
requisitions that currently are or will be assigned to Don. You then can remove

Pilar’s extended approver rights when Don returns, if you choose.

See Select requisition settings for a user on page 13 for more information.

Option 2: Allow creators to change their approvers

You can use the Users or Roles pages to give specific users or roles the ability to
select which approvers their requisitions will be submitted to.
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In this example, you want another user, Toby, to approve the requisitions for Jo and
Chris while Don is away. You add Toby to the approval hierarchy at the same level
as Don, and add Jo and Chris under Toby.

Approval Hierarchy

Select a user or role bo make changes to the approval hierarchy,

= ﬂ|RequisitiDn ﬁdminist‘rab:ur|
= € Fequisition Purchaser
= “fG Pilar Ackerman (pilar - FRVISTA1614)
= % Don Hall {don - FRYISTA1614)
Y% 1o Berry {jo - FRVISTA1G14)
W% Chris Gray (chris - FRYISTA1614)
= 4 Toby Mixon (toby - FRVISTALG14)
¥ 1o Berry (jo - FRVISTALA14)
¥ Chris Gray (chris - FRVYISTALG14)

You must select A user or role can be in the approval hierarchy multiple times on the
Approval Hierarchies page to be able to include a user or role in the hierarchy in multiple
places.

You then use the Users page to allow both Jo and Chris to change their approvers.
See Select requisition settings for a user on page 13 for more information. When Jo and
Chris create their requisitions, they can select Submit and send the purchase
request to rather than just Submit, and select Toby from the list of available
approvers. (Don is still the default approver if they just click Submit.)

This option works only for new requisitions that are submitted; if any requisitions
currently are assigned to Don before he leaves, Toby won’t be able to take action on
those requisitions.

Rather than adding a specific user as the approver, you instead could add the Requisition
Approver role and assign the necessary approvers to that role. Jo and Chris could choose to
submit and send their requisitions to the Requisition Approver role if they were directly
beneath that role in the approval hierarchy.

Option 3: Replace the approver with another user or role

You can use the Approval Hierarchies page to replace a user with another user or
role. When you replace a user, any work items that are assigned to that user will be
assigned to the new user or role.

In this example, you replace Don in the approval hierarchy with Toby. Any
requisitions that are assigned to Don will be assigned to Toby, as will any new
requisitions created by Jo and Chris. When Don returns from his vacation, you can
replace Toby with Don. See Replace a role or user in an approval hierarchy on page 21
for more information.

You instead could replace Don with the Requisition Approver role and assign the necessary
approvers to that role. Any new or existing requisitions would be assigned to the Requisition
Approver role, so all users assigned to that role could take action on the requisitions.
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You can’t replace a user in an approval hierarchy if the user is included in the
hierarchy in multiple places, and the position you're replacing is the default level.
The default level is the level from which the user submits requisitions. See Modify an
approval hierarchy on page 20 for more information.

Company is being modified by another user
If you're modifying a company’s information using the Company Setup page and
you close your browser, you might receive the following message when you
attempt to modify this company’s information again: “This company is being
modified by another user.”
If this occurs, you can wait 20 minutes until the current user session expires, or the
system administrator can complete one of the following tasks so you can access this
company information:
* Clear the appropriate row in the MultiUserManager table using Microsoft SQL

Server® Management Studio (recommended)

¢ Restart Internet Information Services (IIS)

To clear the appropriate row in the MultiUserManager table, complete the following
steps.

To clear a row in the MultiUserManager table using SQL
Server 2005:

1. Open Microsoft SQL Server Management Studio by choosing Start > All
Programs > Microsoft SQL Server 2005 > SQL Server Management Studio.

2. In the Summary pane, double-click Databases list to display your company’s
database.

3. Double-click the DYNAMICS database.

4. Double-click Tables to display the tables in the database.

5. Right-click the MultiUserManager table and choose Open Table.
6. Select the appropriate row. Right-click the row and choose Delete.

7. Confirm the deletion.

To clear a row in the MultiUserManager table using SQL
Server 2008:

1. Open Microsoft SQL Server Management Studio by choosing Start > All
Programs > Microsoft SQL Server 200 > SQL Server Management Studio.

2. In the Object Explorer pane, double-click Databases list to display your
company’s database.

3. Double-click the DYNAMICS database.
4. Double-click Tables to display the tables in the database.

5. Right-click the MultiUserManager table and choose Edit Top 200 Rows.
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6. Select the appropriate row. Right-click the row and choose Delete.

7. Confirm the deletion.

Purchase request is being modified by another user

Requisition Management users may receive a message indicating that the selected
requisition is currently in use, even if no other users are modifying the requisition.

If you determine that no other users are modifying the requisition, the system
administrator should verify the account used by the Business Portal application
pool. The application pool account must be a Business Portal user in order for
Requisition Management processes to be cleared.

By default, the Business Portal application pool uses the Network Service account,
and the Network Service account is a user in Business Portal. If your SQL server is
on Windows 2000 Server, the Network Service account can’t be used. If you
configured Business Portal to use a different account, that account will not
automatically be added as a Business Portal user.

Complete these procedures on your Business Portal web server.

Determine which application pool Business Portal is

using:

1. Open Internet Information Services (IIS) Manager by choosing Start >
Administrative Tools > Internet Information Services (IIS) Manager.

2. Click the plus sign next to your server name.

3. Click the plus sign next to Web Sites.

4. Right-click the web site you installed Business Portal to. (By default, Business
Portal is installed to the Default Web Site.) Choose Properties.

5. In the properties window that appears, click the Home Directory tab.

6. Find the Application pool field. The application pool that is entered in this field
is the Business Portal application pool.

Identify the account used by the Business Portal
application pool:
1. Open Internet Information Services (IIS) Manager by choosing Start >

Administrative Tools > Internet Information Services (IIS) Manager.
2. Click the plus sign next to your server name.
3. Click the plus sign next to Application Pools.

4. Right-click the Business Portal application pool and choose Properties.

5. In the properties window that appears, click the Identity tab. A domain user
account must be specified here.
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6. If a domain user account is not specified, select the Configurable option and
type a domain user name and password. The account you specify must meet
the requirements listed in the “User account for Windows SharePoint Services”
section in the Business Portal Installation Guide.

Set up the domain account as a Business Portal user:

The domain user account you specified for the application pool must be set up as a
Business Portal user. For information about setting up a Business Portal user, see the
Business Portal Administrator’s Guide.

Failed conversion of a requisition to a purchase order

When you're converting a requisition to a purchase order, you might encounter a
purchase order failure error. The following information describes the situations that
might be causing this error.

“More data was found in the result than was expected”

message

This message is displayed because the SY00600 table in the company database
contains company ID values that reference a different company. All company ID
values in this table must be the same.

For example, for the sample company, Fabrikam, Inc., the CMPANYID value should
be -1 for all records in the SY00600 table in the TWO database.

To resolve this, the system administrator must modify the SY00600 table so all the
CMPANYID values are the same:

1. Make a backup of your Microsoft Dynamics GP database.

2. Run the following query on the company database using Microsoft SQL Server
Management Studio:

update SY00600 set CMPANYID = b.CMPANYID
from SY00600 a, DYNAMICS.dbo.SY01500 b
where b.INTERID = db_name()

“The Purchasing purchase option for item XXX does not
exist” message

This message is displayed because the unit of measure (U of M) value is case
sensitive. The default U of M value for requisitions is “EACH,” but this might be
listed as “Each” in Microsoft Dynamics GP.

To resolve this, the system administrator must view and update the IV00101 table:
1. Make a backup of your Microsoft Dynamics GP database.

2. Run the following query on the company database using Microsoft SQL Server
Management Studio:

select PRCHSUOM, * from IV00101
update IV00101 set PRCHSUOM = 'Each' where PRCHSUOM = 'EACH'
update DYNAMICS..RegMgmtLines set UnitOfMeasure = 'Each'
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“Invalid Persisted data, EntityKey Null” message
This message is displayed because of any of the following reasons:

¢ The FREEONBOARD field in the PM Vendor Master File (PM00200) or Item
Vendor Master Table (IV00103) has a status that is not valid.

¢ One or more values in the PM Vendor Master File (PM00200) is null.

* A functional currency has not been set up in Microsoft Dynamics GP.

®  One or more values in the GL Account Master Table (GL00100) is null.

Refer to Microsoft Knowledge Base Article 904039 for more information about these

issues and their resolutions. (Go to https://mbs.microsoft.com/customersource,
choose Support > Knowledge Base, and type 904039 in the Search For field.)
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Chapter 8:

Default group and role permissions

This information lists the default permissions associated with the SharePoint
groups and MBF roles that are installed with Requisition Management.

For more information about SharePoint groups and MBF roles, see the Business

Portal Administrator’s Guide.

This information is divided into the following sections:

¢ SharePoint groups
e MBF roles

SharePoint groups

SharePoint groups are used to grant access to Business Portal sites and pages. The
permission levels associated with each group define the level of control users have
over the securable items on those pages, such as web parts.

pages and document libraries. For example, a user who has the Read permission level for a
page can’t modify the page or the web parts on it. Permission levels do not affect a user’s
access to Microsoft Dynamics GP data. This means that a user with the Read permission
level for a page still may be able to create transactions, modify records, or delete entries using
that page.

~ @/ SharePoint permission levels control whether users can modify SharePoint content, such as

The following table lists the SharePoint groups that are installed with Requisition
Management, and includes the default pages and permission levels associated with

each group.
Group Site Page library Page Permission

level

BP Requisition Employee Center Employee Center Common Pages | Employee Center Home Read
Creator Requisition Management Pages Purchase Requests Read
Purchase Request Details Read

BP Requisition Employee Center Employee Center Common Pages | Employee Center Home Read
Approver Requisition Management Pages Purchase Requests Read
Purchase Request Details Read

Purchasing Center Purchasing Center Common Pages | Purchasing Center Home Read

Requisition Management Pages Commitments Read

BP Requisition Purchasing Center Purchasing Center Common Pages | Purchasing Center Home Read
Purchaser Requisition Management Pages Requisitions Read
Commitments Read

BP Requisition Top-level Business Requisition Management Pages Company Setup Read
Administrator Portal site Approval Hierarchies Read
Roles Read

Users Read

Notifications Read

The BP Administration permission level also is associated with the BP Requisition
Administrator group. This is a custom permission level that gives Business Portal
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application administrators access to the Site Settings page on the top-level Business
Portal web site.

MBF roles

MBEF roles are used to grant access to Business Portal data. The data permissions
associated with each role control access to the back office data that can be displayed
in Business Portal.

The following table lists the MBF roles that are installed with Requisition
Management, and includes the default data permissions associated with each role.

Role Data permissions

Requisition Creator Account - Requisition Management
Item - Requisition Management
ItemVendor - All

OpenTasks - All

ReqgDoc

RequisitionLineRoot - All

Site - Requisition Management
Vendor - Requisition Management

Requisition Approver Account - Requisition Management
Item - Requisition Management
ItemVendor - All

OpenTasks - All

RegDoc

RequisitionLineRoot - All

Site - Requisition Management
Vendor - Requisition Management

Requisition Purchaser RequisitionLineRoot - All

Requisition Administrator | Account - Requisition Management
ApprovalTree - All

Company - Requisition Management
Item - Requisition Management
ItemVendor - All
NotificationContent - All
OpenTasks - All

RegDoc

RegListHistory - All
RequisitionLineRoot - All

Site - Requisition Management
Vendor - Requisition Management
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